Paint Shop Pro 7.02

Release Notes



Thank you for purchasing Jasc® Paint Shop Pro™ 7! Our newest release of Paint Shop Pro is packed with powerful new features and enhancements, including Jasc Animation Shop™ 3.  Once you begin using these programs, we think you will see just how easy it can be to create Web graphics and enhance digital photos.



Please remember that this is a licensed version of Paint Shop Pro, and cannot be freely distributed.  See the license agreement information included in this document for limits on copying this software and other important information.
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Changes in Paint Shop Pro 7.02

This version has resolved the following reported issues:

The Smudge and Push modes of the Retouch brush now function properly.

The Moiré Pattern Removal filter processes grey scale images correctly.

When creating floating text with "Standard text" settings (solid color fill only), the text is now filled correctly with the selected color.

The Clarify filter has been fixed to address cases where it would improperly lighten dark image areas.

Attempting to use a texture or pattern with a extremely large or small aspect ratio (image width divided by image height) will no longer cause a program error.

When changing a setting in certain adjustments and filters and then quickly pressing the <Enter> key to apply the command, the program will now perform the command with the proper settings.  This issue was known to affect the Colors>Gamma Correction command.

Object handles on selected vector text will no longer disappear after the text has been edited.

The "Browse with Paint Shop Pro 7" shell context menu command now properly views the contents of a drive's root directory.



Changes in Paint Shop Pro 7.01

We’ve made several changes to the program to improve overall performance and address known issues reported to us by our customers.  The list below cites the most significant changes in this version of the program.



Program Enhancements

Layer Palette performance has been significantly improved for faster layer and object management.  These performance enhancements are most evident when using the Layer Palette to manipulate images containing several layers and/or vector objects.

A progress indicator has been added to program effects when generating previews or proofing changes.

The Image Mapper and Image Slicer tools have been updated for easier slice/map boundary selection and definition.  Boundary selection requires less precise positioning of the cursor, and the windows now scroll as necessary when defining boundaries.

The Clarify and Moiré Pattern Removal photo effects have been updated for better performance.

The Average, Median, Edge and Texture Preserving Smooth, Manual Color Correction, Salt & Pepper Filter, Histogram Adjustment, and all automatic photo enhancement filters now support transparent layers.

The Retouch mode selection droplist is now located on the first tab of the Tool Options palette for easier mode selection.

The “Sample merged” option is now available when using the Retouch tool with the Sharpen, Soften, and Emboss retouch modes.

The “Paint Shop Pro Folders” special folder options in the Browse for folder dialog box now include a listing for the Shapes folder

A “Create new folder” command has been added to the File menu when a browser window is active.  The command will allow the user to create a new folder as a subdirectory of the folder currently being viewed by the browser. A button may be added to the Browser toolbar for this command if desired.

When performing multiple screen captures, the minimum window size of each capture has been increased to ease identification of small captures, such as individual menu items.



Fixes

A display issue causing the Effects menu to remain on screen after use has been resolved.

When cropping an irregular selection area, the area outside of the selection is now either filled with the current background solid color (when performed on a background layer) or rendered transparent (when performed on a raster layer).

An issue that could cause an application error when using the Proof and Auto Proof options in the Text Entry dialog on a background layer has been resolved.

The Rotate command operates correctly after moving a layer containing a mask while in Mask Edit mode.

The Histogram and Overview windows are properly updated after performing a crop.

When creating or resizing a crop marquee using the mouse, the ruler operates in the same manner as the Selection tool by displaying the affected area as a dashed line.

Plug-in filters that have been properly removed from paths used by the program will no longer be listed as available plug-in filters or file import/export options.

DPI information is correctly passed to file export plug-in filters

The Sculpture and Texture effects correctly preview and apply rectangular patterns.

The Colors>Adjust>Hue/Saturation/Lightness command processes Lightness value changes properly.

The Page Curl effect will no longer leave white spots at the edge of the curl.

When using the Save, Save As, and Preview commands, the Image Mapper properly processes vertical map boundaries when they do not extend across the entire map grid.

The Image Slicer will no longer generate an error when using the Grid tool and clicking on an area outside of the document in the preview window.

Information in the “Target” field is now retained when saving Image Slicer settings.

Vector objects are properly redrawn when they are on different layers and their properties are collectively modified after being selected with the Object Selector tool.

Attempting to group existing vector object groups will no longer cause an application error.

Gradient fill colors are retained when changing vector object properties when the current foreground or background solid colors differ from the active colors at the time the object was created.

Nested vector group names are properly retained.

When pasting a new layer, a display problem that would cause a second instance of the pasted data to temporarily appear has been corrected.

Layer group values are retained when layer positions are modified using the Layer Palette.

The JPEG and GIF Wizards output properly when run with their default options.

When using the Save As command to save in JPEG format, designating a new path and filename, then launching the JPEG optimizer, the new path and filename are retained when the optimizer returns to the Save As dialog box.

A problem that could prevent the browser from displaying thumbnails of supported file types when the browser’s cache file was read-only has been corrected.

Image size and memory information is no longer clipped off the right edge of the Status Bar when running the program in a normal window at a screen resolution of 800 x 600.

When the position of the previewed area is changed using the four-arrowhead button in affected program dialog boxes, the change is now retained when using the Zoom In/Out controls.

Rulers are now properly synchronized when images are viewed at negative zoom levels.

The brush and Scratch Remover tools now function properly after closing some instances of the Page Setup or Multiple Image Printing views.

1- and 4-bit images are properly processed and previewed when used as a pattern by program tools and effects.

Several minor issues with using Undo to discard changes to vector content and masks have been corrected.



Changes in Paint Shop Pro 7.0

We have added several great new features and enhancements to Paint Shop Pro 7.0. The most significant product changes are listed below.  For a more detailed explanation of these features, please consult the Paint Shop Pro 7 Help file.



Photo Enhancement

Automatically adjust color balance, contrast, and saturation.

Remove red-eye on people and animals.

Restore damaged photos with Scratch Removal Tool.

Adjustable Histogram enhances details without loss of information.

Automatically improve video, scanned, and overly compressed images. 

Automatically remove noise, scratches, dust, or specks and improve crispness and impact.



Business/Home Graphics

Vector shapes, lines, and text now support gradients, textures, and patterns on the stroke and fill.

Brushes now support gradients, textures, and patterns.

Align, distribute, arrange, group and resize vector objects.

Create and save custom-styled lines with dots, dashes, and end-caps.

Create and save custom shapes for reuse.

Position more precisely with snap-to grids and guides.

Experiment with over 25 new artistic and lighting special effects.



Web Design

Create professional-quality GIF animations with Animation Shop 3.

Preview graphics in various Web file formats in up to three browsers.

New PNG optimizer for high Web performance.

An Image Mapper and Image Slicer with JavaScript rollover creation support.



Productivity & Ease of Use

Repeat last command feature.

Save and retrieve workspaces to manage projects.

Quickly identify and select with thumbnail previews of Picture Tubes, Gradients, Textures, Patterns, and Preset Shapes.

Navigate easier while in Zoom mode with the Overview Window Palette.

Protect critical work with customizable Auto-Save.

Easily view your adjustments with proofing, autoproofing, and reset options on most dialogs.



Changes in Animation Shop 3.02

A duplicate sample animation file (Insert&Apply.mng) has been removed from the program installation.



Changes in Animation Shop 3.01

The list below cites the most significant changes in this version of the program.

An issue that could cause program instability when attempting to open corrupted FLI and FLC files has been corrected.

Canceling the Optimization Wizard will no longer return an application error. 

The Help button in the Open dialog box now displays the correct topic.

A warning message dialog box now appears when attempting to open a MNG file that contains unsupported features.  The program currently supports MNG-LC.



Changes in Animation Shop 3.0

We have added several great new features and enhancements to Animation Shop 3.0. The most significant product changes are listed below.  For a more detailed explanation of these features, please consult the Animation Shop 3 Help file.



Integration of the Paint Shop Pro browser into Animation Shop, providing an intuitive manner for you to select image files to include in animations and open in the application.

An Onionskin Preview mode allows you to preview an overlay of frames before and after the current frame for more precise animation editing and creation.

A variety of frame and animation modification options have been added, including frame rotation options, a Mover tool, a color replacement command and floating text and image placement.

New animation preview options, including enhancements to the Optimization Wizard and the ability to preview the current animation in your selected Web browser.

A new Morph transition, for enhanced fade effects using customizable key points between frames.

A new toolbar with VCR-style controls that allow you to play, fast-forward and rewind your animation.

Support for reading MPEG-format video files.

Enhanced integration between Animation Shop and Paint Shop Pro, including enhanced multiple-layer export and the ability to export all or part of an animation as a tube to be used with Paint Shop Pro.



Obtaining and Installing Direct Digital Camera Support

Paint Shop Pro provides direct support for many popular digital cameras. A separate installation program for this support is included with the CD-ROM version of Paint Shop Pro.  This installation program is also available for download from our Web site at www.jasc.com for customers who purchased the electronic download version of Paint Shop Pro.  A list of supported cameras is also available at this location.



The CD-ROM version of Paint Shop Pro will create a Start Menu shortcut for the digital camera support installer in the Jasc Software\Utilities folder during program installation.



To install direct digital camera support, proceed as follows:

1.   If you purchased an electronic download version of Paint Shop Pro, download the Jasc Software Digital Camera Support setup program.

2.   Run the camera installation program by selecting the "Jasc Digital Camera Support" shortcut in the Jasc Software\Utilities folder of the Start Menu (CD-ROM version) or double clicking on the file you downloaded in step 1.

3.   Select the appropriate camera from the list of available devices. By default, no cameras are selected in the setup program. To select the desired camera, click on the disk icon to display a menu of available installation options, then click the "This feature will be installed on local hard drive" option.

4.   The installation program will install the necessary files for accessing the selected camera(s) and close after the installation is complete.

5.   Once the desired support is installed, you can configure and access the camera using the Import>Digital Camera commands on Paint Shop Pro's File menu.



Note: Kodak DC120 and DC2xx model cameras are supported internally and do not require this component.



Direct Digital Camera Support and the Certified for Windows Logo

Please note that although the Jasc Digital Camera Support component included with this product has been tested and operates properly under Windows 95, Windows 98, Windows NT 4, and Windows 2000, it does not carry the "Certified for Windows" logo.  This add-on utility is not required to use this product under any supported platform.



Obtaining Technical Support



Technical support for Paint Shop Pro 7 and Animation Shop 3 can be obtained from:



Jasc Software, Inc.

PO Box 44997

Eden Prairie, MN 55344 USA

Voice:	(952) 930-9171

Fax:	(952) 930-9172

Internet:

   Paint Shop Pro:	psp7sup@jasc.com

   Animation Shop:	anm3sup@jasc.com

Web:	www.jasc.com



International customers can also contact their regional master representative for technical support.  To obtain contact information for your regional master representative, please see the International Master Representatives List page on our Web site at http://www.jasc.com/world.asp or contact our Technical Support department using the information provided above.



Installation Notes for Try & Buy and ESD Version Users

Although Paint Shop Pro 7.02/Animation Shop 3.02 can be purchased on CD-ROM, Paint Shop Pro 7.02 and Animation Shop 3.02 are available as Try & Buy and ESD (Electronic Software Distribution) versions.  The Try & Buy version is for users who wish to try our products before making a purchasing decision; the ESD version is for users who wish to purchase and download the licensed version of the software and do not require product manuals.



Please note that the Try & Buy and ESD installations work differently than the installer used on the Paint Shop Pro 7.02 CD-ROM.  These versions extract the files required to install Paint Shop Pro and Animation Shop to a user-defined location on the user's hard drive, then begin the installation.  The extracted files are not removed from the user-defined location after the installation is finished because they are required if you ever wish to modify your current installation (e.g., add or remove components such as Picture Tubes or sample animations using the "Modify" option in the program installation).



Because of this difference, these versions require additional hard drive space (to store the downloaded file, the extracted setup files, and the installed program).  If you wish to reclaim this disk space, perform the following tasks:



1.   Archive the downloaded Try & Buy or ESD version to removable media such as a Zip® disk or CD-R.  We strongly recommend ESD purchasers to perform this step.

2.   Note the location where the installation files have been extracted. These files will be extracted to the C:\Program Files\Jasc Software Inc\Setup Files\ folder by default.  You may then delete these files. If these files are deleted you will be unable to modify your installation without running the downloaded Try & Buy or ESD installer again.  We recommend performing this step only if you do not intend to modify your installation.



Modifying a Paint Shop Pro or Animation Shop Installation After Removing Extracted Files

If you deleted the extracted installation files as described in step 2 above and you wish to modify your installation, re-run the downloaded Try & Buy or ESD installation files from your archive disk, and select the "Modify" option offered during the installation.



Software License and Limited Warranty



This is a legally binding agreement between you and Jasc Software, Inc. ("Jasc"). By installing and/or using this software, you are agreeing to become bound by the terms of this agreement.

IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE THIS SOFTWARE. PROMPTLY RETURN THE ENTIRE PACKAGE TO THE PLACE WHERE YOU OBTAINED IT FOR A FULL REFUND.



GRANT OF LICENSE. Jasc grants to you a non-exclusive right to use this software program (hereinafter the "Software") in accordance with the terms contained in this Agreement. You may use the Software on a single computer. If you have purchased a site license, you may use the Software on the number of computers defined by and in accordance with the site license. 



UPGRADES. If you acquired this Software as an upgrade of a previous version, this Agreement replaces and supercedes any prior Agreements. You may continue to use the previous version of the Software, provided that both the previous version and the upgrade are installed on the same computer at all times.  You may not have a previous version and the related upgrade version installed on separate computers at any time. 



OWNERSHIP OF SOFTWARE. Jasc and its suppliers retain the copyright, title and ownership of the Software and the written materials. 



COPIES. You may make one (1) copy of the Software solely for backup purposes. You must reproduce and include the copyright notice on the backup copy. No other copying is permitted. You may not distribute copies of the Software or accompanying written materials to others.



TRANSFERS. You may transfer the Software to another person provided that you notify Jasc of the transfer and the person to whom you transfer the Software agrees to be bound by this Agreement. You may also transfer the Software from one of your computers to another. Upon a transfer, you must remove all copies of the Software from the computer from which it was transferred. Upon a transfer to a third party you must destroy all backups. In no event may you transfer, assign, rent, lease, sell or otherwise dispose of the Software on a temporary basis. 



TERMINATION. This Agreement is effective until terminated. This Agreement will terminate automatically without notice from Jasc if you fail to comply with any provision of this Agreement. Upon termination you shall destroy the written materials and all copies of the Software, including modified copies, if any.



LIMITED WARRANTY. Jasc warrants the media on which the Software is furnished to be free of defects in material and workmanship, under normal use, for a period of ninety (90) days following the date of delivery to you. In the event of defects, Jasc's sole liability shall be to (a) replace the defective media or (b) refund the purchase price, at Jasc's option. You must return the Software to Jasc or an authorized dealer with your dated invoice during the 90-day warranty period in order to receive a refund or replacement. 



DISCLAIMER OF WARRANTIES. JASC DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  

OTHER WARRANTIES EXCLUDED. JASC SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, EXEMPLARY, PUNITIVE OR INCIDENTAL DAMAGES ARISING FROM ANY CAUSE EVEN IF JASC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. CERTAIN JURISDICTIONS DO NOT PERMIT THE LIMITATION OR EXCLUSION OF INCIDENTAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU.

IN NO EVENT WILL JASC BE LIABLE FOR ANY AMOUNT GREATER THAN WHAT YOU ACTUALLY PAID FOR THE SOFTWARE. Should any other warranties be found to exist, such warranties shall be limited in duration to ninety (90) days following the date you receive the Software.



EXPORT LAWS. You agree that you will not export the Software or documentation except in compliance with the laws and regulations of the United States.



US GOVERNMENT RESTRICTED RIGHTS. The Software and any accompanying materials are provided with Restricted Rights. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable. Contractor/manufacturer is Jasc Software, Inc., PO Box 44997, Eden Prairie MN 55344.



GENERAL. This Agreement shall be governed by and construed in accordance with the laws of the State of Minnesota and the Federal Arbitration Act and shall benefit Jasc, its successors and assigns. Any claim or dispute between you and Jasc or against any agent, employee, successor or assign of Jasc related to this Agreement or the Software shall be resolved by binding arbitration in Minneapolis, MN by and under the rules of the American Arbitration Association. Any award of the arbitrator(s) may be entered as a judgment in any court of competent jurisdiction. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement.
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